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Course Objectives 

• Overview of the GTA Reconciliation Process

• Preparing GTA files for Reconciliation

• Importing and Preparing Adjustments

• Running the Autoreconciliation Program and Reports

• Researching Exceptions and Reconciling Lines
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Agenda

Day 1

1. Discuss the GTA Reconciliation Process

2. Preparing GTA files for Reconciliation

3. Importing and Preparing Adjustments

4. Running the Autoreconciliation Program and Reports
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Agenda

Day 2

1. Reviewing Reports

2. Resolving Reconciliation Errors
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Agenda

Day 3

1. Resolving Reconciliation Errors

2. Create Manual Adjustments in AP

3. Reconci le Lines
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Training Guidelines 

1. Ask Questions

2. Cheating is encouraged

3. Don’t let me get ahead

4. Have fun!
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Accessing Oracle via the NIH Portal

¾ Oracle is a web-based application available via the NIH Portal

¾ NIH Portal website:  http://my.nih.gov
� To Log on use your:
� NIH Domain
� User Name
� Password

� For assistance, contact NIH Help Desk at 6-HELP (301.496.4357).

¾ Add the Budget & Finance Community, which is the page where the 
Oracle application resides

 



   

NIH Cash Management GTA User:  Course Overview   
 Chapter 1 - Page 9  

Logging in to the NIH Portal 

Page 7

Logging in to the NIH Portal

 
Follow steps below to access the NBS Travel System application from the NIH Portal. 
• Launch Internet Explorer.  In the browser, navigate to the NIH Portal at http://my.nih.gov. 

(Note: If you need Internet Explorer installed on your computer, please contact the NIH Help 
Desk at 6-HELP (301-496-4357)  

• Sign in to the NIH Portal according to the steps listed below, using the account information 
you currently use to log on to Windows at your workstation. 

• Select your domain from the pull-down menu. (Hint: Use the "Which 
domain should I select? link for assistance.)  

• Enter your User name. 
• Enter your Password. 
• Click the Log in button. 

 
For Portal account and password assistance, contact the NIH Help Desk at 6-HELP (301-496-

4357). 
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Adding a Community to your NIH Portal View

1

2

3

4

5

 
What is a Portal Community and how do I subscribe to a Portal Community? 
 
Portal Communities provide content, documents and application access to users who have a 
common area of interest.  Once you subscribe to a community, it will appear in the list on your 
Communities tab every time you visit the NIH portal.  Follow the steps below to subscribe to a 
community. 
 

•  Click on the “Communities” tab and select “Edit Your Memberships”.  
•  Locate a community of interest either by clicking a folder to browse for communities or 

by entering a key word in the Search field and clicking "Go" to look for a specific 
community. 

•  Once you locate a community of interest, select it by clicking in the box next to the 
community name. 

•  Click “Add to my Memberships”. (You may need to select your default community.) 
•  Click “Finish”.  The subscribed community will now appear in the list on your 

“Communities” Tab every time you access the portal.  
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Questions

Questions?
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Lesson Objectives 

After this lesson you will know:

• The process to pay Impac Government Services

• The process to reconci le GTA charges from the NBS 
Travel System to the TMC files and invoice information

• The guidelines for GTA adjustments

• The reports available to assist with the reconciliation 
process
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Why Reconcile GTA Charges?

The purpose of the GTA Reconciliation process is to verify that the travel 
goods and services procured through the NIH Travel Management 
Centers have been properly entered as expenses in the NBS Travel
System

NBS Travel 
System

INVOICE
Ticket: $500.00
Fee: $30.00
Ticket: $400.00
Fee: $30.00

Total: $960.00

Remit to Impac 
Gov ernment 
Serv ices

Match?
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Travel Management Centers and Impac 
Government Services

¾ Majority of airline tickets and associated charges are centrally (directly) 
billed to the NIH and purchased through one of NIH’s Travel 
Management Centers (TMCs)

¾ The TMC charges purchases and fees directly to one of NIH’s eight 
credit card accounts

Staff 
Patient

NIA
NIDA

NIDDK (Omega, Phoenix)

Omega

NIAIDSeamont
NIEHSAAA

NCICarlson

AccountsTravel Management Center

¾ Impac Government Services (aka US Bank) is the company that 
sponsors the credit card.  
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Payment to Impac Government Services

Travel Management Center
Impac Government Services

(US Bank)

OFM Travel Office

Invoice with
flat file

Payment based 
on updated 
TMC invoice

Payment

Updated i nvoice 
with flat file

1

2

3

 
1.  U.S. Bank sends an invoice, including a file that includes all GTA transactions for the month, 
per account to OFM and the appropriate TMC 
2.  The TMCs 

 - review the file for errors 
 - contact US Bank if necessary 
 - make updates to the file (include credits for cancelled trips, updates on ticket costs if 
erroneous) 
 - send a copy of modified file to OFM Travel Office 
 - send hard copies of backup documents to the OFM Travel Office  

3.  The OFM Travel Office  
 -  reviews the files from U.S. Bank and the TMCs 
 -  processes payment to U.S. Bank based upon the total amount due noted on the TMCs’ 
records for each account 
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Notes:   
Transactions tied to record of calls will be paid from the legacy system.  This split in payment 
and reconciliation will continue until the deployment of Track 4.  
 
The payment to Impac Government Services will be made through a manual ECS schedule 
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Oracle 
Cash 

Management

How do we reconcile GTA charges?

We reconcile GTA charges using Oracle Accounts Payable and Cash 
Management.

NBS Travel 
System

INVOICE
Ticket: $500.00
Fee: $30.00
Ticket: $400.00
Fee: $30.00

Total: $960.00

Remit to Impac 
Gov ernment 
Serv ices

Oracle 
Accounts 
Payable

 
Individual ticket charges and fees are imported into Accounts Payable and recorded. 
The invoices containing the ticket charges and fees are imported into Oracle Cash Management.   
Oracle Cash Management reconciles the payments in Accounts Payable with the invoiced 
amount. 
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Travel Invoices in Accounts Payable

AP Open 
Interface

AP
Invoice 

Workbench

AP  
Payment 

Workbench

NBS Travel 
System

• Inv oices and 
Debit Memos 
imported f rom 
NBS Trav el 
Sy stem

• Inv oices 
imported f rom 
Cash 
Management

• Inv oices imported 
f rom Open 
Interf ace

• Inv oices are 
placed on hold

• Pay ments are 
recorded

G
TA

 H
O

LD
• Inv oices are 

Validated

• Inv oices are 
released 
f rom the hold

Cash 
Management

• Pay ments are 
reconciled

 
GTA Invoices that are interfaced from the NBS Travel System are on hold.   
In order for them to be recorded, you must validate the invoices and release the hold.   
Once the hold is released and the invoices are validated, the payments are recorded.   
The holds should be released and the payments recorded on a daily basis. 
 
GTA Invoices that are interfaced from the NBS Travel System are: 
•   Payable to Impac Government Services 
•   Identified by an invoice number equal to the travel order number appended with “– CB” 
•   On hold – Awaiting Reconciliation 
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Reconciling GTA Charges

1.  Prepare GTA Invoices

2.  Record Payment

NIH Payables User 
Prepares GTA Invoices

DAILY

DBA Loads File and 
Runs Custom Program

Prepare and Load File

Email GTA User w hen 
complete

NIH GTA User Prepares 
Adjustments and 
Reconciles File

1.  Import Adjustments

2.  Record Adjustments 
and Credits

3.  Import and Reconcile 
TMC File

4.  Run Reconciliation 
Reports

5.  Research and 
Manually Reconcile 

Exceptions

NIH GTA User Prepares 
TMC Files for 
Reconciliation

1.  Prepare TMC File

2.  Save File on Drive

3. Email DBA

Monthly 

 
Note:  Prior to beginning the Monthly process for the TMC files, the NIH Payables User 
should ensure that no standard invoices payable to Impac Government Services remain 
unpaid. 
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Illustration of GTA Reconciliation Process

AP Cash Management
Bank Reconciliation

# Invoice #   Amount   Reconciled?

1 TR25 $150     Yes
2 TR26 $1125   Yes
3 TR27 $857     Yes
4 TR28 $125     Yes
5 TR29 $736     Yes
6 TR30 $356     Yes 
7 TR31 $125     Yes

1125

150

Amount

TR26

TR25

Document #

TMC File

NBS Travel System

Invoice Workbench

Invoice#      Amount           Hold?
TR25V1-CB $150          Yes
TR26V1-CB $1125        Yes
TR27V1-CB $857          Yes
TR28V1-CB $125          Yes
TR29V1-CB $736          Yes
TR30V1-CB $356          Yes
TR31V1-CB $125          Yes

Adjustments
Invoice # Amount
TR24V1-CB GTA          $100
TR33V1-CB GTA          $30.50
TR20V1-CB CM          -$100
TR35V1-CB DM          -$100

Payment Workbench

Invoice#        Amount   Document

TR25V1-CB $150  Recorded
TR26V1-CB $1125Recorded
TR27V1-CB $857  Recorded
TR28V1-CB $125  Recorded
TR29V1-CB $736  Recorded
TR30V1-CB $356  Recorded
TR31V1-CB $125  Recorded

Adjustments
Invoice # Amount
TR24V1-CB GTA          $100
TR33V1-CB GTA          $30.50
TR20V1-CB CM          -$100

 
Daily GTA Reconciliation Support Activities include: 
 

1. When the travel voucher is approved in the NBS Travel System containing a GTA 
expense, an invoice payable to Impac Government Services is created and inserted into 
Accounts Payable (AP) Open Interface.   

 
2. During import process from the AP Open Interface table, the invoices pulled into the AP 

workbench with the supplier name “IMPAC Government Services” will be put on 
“Awaiting Reconciliation” hold.    

 
3. The NIH Payables User will release hold on these invoices, and record payment.  The 

recording of these individual payments is required in order for the reconciliation process 
with cash management to work. 

 
4. 4.The NIH Payables User will generate the Invoices on Hold report for Reconciliation 

Hold to ensure that no invoices for Impac Government Services remain unpaid. 
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Automatic Creation of Adjusting Entries

¾ In order to facilitate the reconciliation process, a custom program has 
been created to automatically create adjusting entries in Accounts 
Payable based upon the information located in AP and the TMC File.

¾ These adjustments are imported into the AP Open Interface.

NBS

Inv oice#       Amount

TR25V1-CB     $150
TR26V1-CB     $1125

Adjustments Needed

TMC File

Inv oice#   Amount

TR25 $100
TR26 $1500
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TMC File Amount = AP Invoice Amount

The transaction line will return a status of “Reconciled”

The Auto-reconciliation Program Guidelines
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TMC File Amount > AP Invoice Amount
¾ An adjusting invoice will be created in AP and automatically 

reconciled if
� The transaction is not sponsor related AND
� The same travel order has not been previously reconciled, or adjustments 

created against it such as a debit memo.  

¾ If the transaction is sponsor related, a message will be raised in Cash 
Management and also be reflected on a report that the transaction is 
tied to a sponsored activity.  
� The user would enter a manual invoice in AP using a direct Project 

reflected on the output report as the direct Project (CAN) for that 
transaction and manually reconcile the invoice to the TMC file. Accounts 
Receivable Sponsor Travel contact will be notified of adjustment entries.

¾ If a debit memo exists for the travel order, an exception will be raised.  
The user will manually clear the debit memo against new transaction. 

The Auto-reconciliation Program Guidelines
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The Auto-reconciliation Program Guidelines

TMC File Amount < AP Invoice Amount
¾ For Sponsor or Non-Sponsor documents, the custom extension would 

create a Debit Memo using the travel order number appended with 
“GTA.” The Debit Memo would be manually reconciled to the TMC 
File.

¾ For refunds reflected on the TMC file, the custom extension would 
create a credit memo in Accounts Payable.  The user will have to
manually update these records as cleared in AP workbench.
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Communicating Adjustments to the ICs

¾ The GTA Cash Management User sends an email (using a predefined 
template) to the Org Admin requesting they review a report detailing 
the adjustments made to their organizational projects based on the 
GTA Reconciliation.  

¾ The Org Admin will be able to view this report by accessing a link 
provided on the email message to them.

¾ Should Org Admin disagree with the adjusting entries made by OFM, 
they must contact the Travel department to reverse entries or contact 
TMC for adjustment to be reflected in the next statement.
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Reports

For NIH Cash Management GTA User
¾ NIHCE Reconciliation Interface Log
� Displays import and reconciliation errors that occurred when running the 

Auto Reconciliation program

¾ Bank Statement Detail Report
� Displays statement and transaction information for a TMC file, including 

reconciled and unreconciled lines.

¾ Transaction Available for Reconciliation Report
� Displays all transactions available for reconciliation for a specific TMC file

 
Bank Statement Detail Report:  This report shows statement and transaction information for a 
TMC file, including statement header information, statement line detail, and reconciled 
transaction detail. This report lists any unreconciled transactions separately with their current 
status, and the statement totals for each type of transaction, including the amount entered, 
reconciled, unreconciled and over-reconciled. The user will also have the option to run the report 
for only unreconciled statement lines. 

 
Transaction Available for Reconciliation Report: This report shows all transactions available 
for reconciliation for a specific TMC file. 



   

GTA Reconciliation Overview   
 Chapter 2 - Page 18  

Reports (cont’d) 

Page 15

Reports (cont’d)

For Organization Administrators
¾ Adjustment Report by Org Admin 
� Report detailing adjustments made by the Travel department to reconcile 

TMC files.  Org Admins will be given a link to pull reports based on Org 
Admin parameter.

For OFM Analyst
¾ OFM Analyst report.
� nVision report displaying data related to a specific travel document number

For DBA
¾ Report Log generated after Upload into Cash Management process.
� This report will be generated after DBA process to upload information into 

the Cash Management tables is complete.  DBA will validate that all rows 
on file are uploaded.
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Report Data

¾ Adjustment Report by Org Admin will contain the following data. The report will 
also be pulled by Org Admin, Start and End Date:

Date expense vouchered and sent to APVoucher Date

TMC NameTMC

Date of adjustment EntryAdjustment Date

Name of Project/NumberProject Name/Number

Date expense vouchered and sent to APTravel Voucher Amount

Date file reconciledReconciliation Date

Invoice amount created by custom extension for varianceAdjustment entry amount

Amount reflected on TMC file as charged to accountAmount on TMC file

Amount sent from Gelco as expensesAmount Vouchered

Invoice number created for VarianceAdjustment Entry Invoice Number

Invoice Number (same as Voucher number)Vouchered Invoice Number

Purchase Order number (same as Authorization number in 
Gelco

Travel Order Number

Funding OrgExpenditure Org/IC

Direct CAN or Reimbursable CAN (Sponsor)Direct or Reimbursable 

DESCRIPTIONDATA
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Analyst Report Data 

¾ Analy sis report will help in detail research.  The report will contain the following data:

Date of adjustment EntryAdjustment Date

Date of Purchase OrderObligation Date

Date expense vouchered and sent to APVoucher Date

Date file reconciledReconciliation Date

Traveler or TMCVendor

Fiscal Funding YearFiscal Year

Amount on Purchase OrderObligation Amount

Amount paid in advance to travelerAdvance

Amount paid in total (listed by line, and reflects total)Disbursement Amount

Invoice Number for adjusted entryAdjusted Invoice Number

Invoice Number (same as Voucher number)Vouchered Invoice Number

Purchase Order number (same as Authorization number in 
Gelco

Travel Order Number

Direct, Sponsor, or In-KindType of Funding

Project Name/NumberProject

Funding OrgExpenditure Org/IC

Direct CAN or Reimbursable CAN and flag if Type, Sponsor, 
Direct, Reimbursable.  For Sponsor transactions, there will be a
reimbursable and direct CAN information provided.

Direct or Reimbursable

DESCRIPTIONDATA
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Amount accepted from SponsorAccepted (Sponsor)

Amount billed sponsorBilled (Sponsor)

Amount collected from sponsorCollected (Sponsor)

Debit/Credit entries created for transactionSGL Entries

Traveler or TMCVendor

Date file reconciledReconciliation Date

Date on invoice was created in AP for Gelco VoucherVoucher Date

Date of Purchase OrderObligation Date

Date of adjustment EntryAdjustment Date

Description of expensesItem Description

DESCRIPTIONDATA

Analyst Report Data (cont’d)
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Lesson Summary 

After this lesson you should know:

• The process to pay Impac Government Services

• The process to reconci le GTA charges from the NBS 
Travel System to the TMC files and invoice information

• The guidelines for GTA adjustments

• The reports available to assist with the reconciliation 
process
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Lesson Objectives 

After this lesson you will know how to:

• Prepare TMC Invoices for Reconciliation

• Import and Record Adjusting Entries

• Run the Cash Management Reconciliation Program

• Run Reports to Review Reconci liation Results
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Reconciling GTA Charges

DBA Loads File and 
Runs Custom Program

Prepare and Load File

Email GTA User w hen 
complete

NIH GTA User Prepares 
Adjustments and 
Reconciles File

1.  Import Adjustments

2.  Record Adjustments 
and Credits

3.  Import and Reconcile 
TMC File

4.  Run Reconciliation 
Reports

5.  Research and 
Manually Reconcile 

Exceptions

NIH GTA User Prepares 
TMC Files for 
Reconciliation

1.  Prepare TMC File

2.  Save File on Drive

3. Email DBA

Monthly 
2

When the DBA loads the TMC file, the 
custom program is run to generate the 
appropriate adjustments:  invoices, 
Debit Memos, and Credit Memos.  
These adjustments will be loaded into 
the AP Open Interface Table

Loa ding the 
File

2

1

Prior to beginning the monthly 
processing of the TMC files, you should 
verify that all standard invoices payable 
to Impac Government Services have 
been validated and payments have 
been recorded

Monthl y 
Processing

1

 



   

GTA Reconciliation   
 Chapter 3 - Page 5  

Preparing the TMC Invoices 

Page 3

Preparing the TMC Invoices 

After this lesson you will know how to:

ÎPrepare TMC Invoices for Reconciliation

• Import and Record Adjusting Entries

• Run the Cash Management Reconciliation Program

• Run Reports to Review Reconci liation Results
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TMC File Preparation

¾ The OFM Travel Office will continue the current practice of reviewing 
the invoices and disputing charges.

¾ We recommend that the OFM Travel Office scan the TMC files to 
ensure that the ADB and NBS charges have been properly 
segregated.

¾ If not, then you must segregate the files manually in Excel.

1.  Prepare TMC File¾ TMCs will send an invoice and two flat files for 
each account, charges segregated by the 
source systems: 
� NBS (Travel document numbers beginning with TR)
� ADB (Travel document numbers beginning with W or N)

 
ADB Files are processed in the same manner as they are processed currently. 
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TMC File Preparation

If the TMC does not send a file, you must
create one in Microsoft Excel. 

Use the following column headings:

1.  Prepare TMC File

PROJECT# TO#  TKT AMOUNT OC AIRLINE TICKET# INVOICE# TRAVELER TRAVEL TYPE ISSUE DATE
106176 TR10023V1 $264.00 2185 2V 7.58E+09 89391 DILAURO/M 3 10/13/2003
106176 TR10023V1 $36.01 2185 XD 8.13E+09 89393 DILAURO/M 3 10/13/2003
107971 TR10035V1 $325.00 2185 NW 7.57E+09 45795 KVIST/K 1 10/11/2003
107971 TR10035V1 $325.00 2185 NW 7.57E+09 45795 KVIST/K 1 10/11/2003
107971 TR10035V1 $30.50 2185 XD 8.13E+09 45797 KVIST/K 1 10/11/2003
107971 TR10035V1 $30.50 2185 XD 8.13E+09 45797 KVIST/K 1 10/11/2003
107971 TR10035V1 $30.50 2185 XD 8.13E+09 45798 KVIST/K 1 10/11/2003

 
Important:  You must use the column headings as they are displayed above.  Failure to use the 
exact column headings may result in file import errors.   
 
You will be given a template to use for this task. 
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Saving TMC Files

¾ Each of the eight accounts will have a separate
flat file

Bank Statement Name

NIADmmyy

NIEHSmmyy

NCImmyy

NIDDKmmyy

NIDAmmyy

NIAmmyy

B10mmyy

B31mmyy

File Name

NIA

Patient

NIDA

StaffOmega

NIDDK (Omega 
Phoenix)*

NIAIDSeamont

NIEHSAAA

NCICarlson

AccountsTMC

¾ The file must be saved as a comma deliminated text file with an 
extension .csv

2.  Save File on Drive
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Saving TMC Files in CSV Format

Each file must be saved as a CSV file on a 
shared drive in a folder designated for the month  

TMC Files
1003

B101003.csv
B311003.csv
NIEHS1003.csv
NIDDK1003.csv
NIA1003.csv
NIDA1003.csv

1103
B101103.csv
B311103.csv
NIEHS1103.csv
NIDDK1103.csv
NIA1103.csv
NIDA1103.csv

2.  Save File on Drive

 
You should create a folder for each month.   
You may label it with the month and year.   
In each monthly folder, you will save the 8 csv files. 
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Saving TMC Files in CSV Format

Each file must be saved as a CSV file 

¾ Open the file using Microsoft Excel
¾ From the menu bar, select File > Save As
¾ Select the drive to save the file 
¾ In the Name field, use the naming convention on the earlier slide.
¾ In the  Type field, select CSV (comma deliminated)
¾ Press Save

2.  Save File on Drive
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Email DBA

¾ You must email the files to the NBRSS – DBA 
mailbox as attachments.

¾ Copy all GTA users on the email to the DBA so 
they are aware of the status of the files.

¾ Once the DBA receives the email, they will 
complete their required steps.

3. Email DBA

 
The email must be sent to the NBRSS – DBA mailbox (nbrssdba@mail.nih.gov) 
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DBA Processes and Confirmation

¾ Once the DBAs receive the email, they will 
complete their required steps:
� The custom program will be run to create the 

appropriate adjustments included standard 
invoices, debit memos, and credit memos based 
upon the agreed upon criteria.

� The interface tables will be loaded with the results 
of the custom program

¾ Upon completion, the DBAs will respond to the 
individuals listed on the original email to confirm 
that the file is ready for processing

3. Email DBA

File Ready!
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Practice Lab

Lab Time

 
Complete Lab 1:  Preparing GTA Files for Reconciliation 
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Import and Record Adjusting Entries 

After this lesson you will know how to:

• Prepare TMC Invoices for Reconciliation

ÎImport and Record Adjusting Entries

• Run the Cash Management Reconciliation Program

• Run Reports to Review Reconci liation Results
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Adjusting Entries

The custom program creates three types of adjusting entries:

TRxV#-CBGTACMFile contains CreditCredit Memo

TRxV#-CBGTADMFile < AP PaymentDebit Memo

TRxV#-CBGTAFile > AP PaymentStandard Invoice

Naming ConventionReasonAdjustment Type

1.  Import Adjustments
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Importing GTA Adjustment Invoices

¾ Adjustment Invoices are created and placed in 
the AP Open Interface Table

¾ The first step is to import them into the AP 
Invoice Workbench

¾ This may be done once for all files

AP Open 
Interface

AP
Invoice 

Workbench
• Inv oices 

imported f rom 
Cash 
Management

• Inv oices imported 
f rom Open 
Interf ace

1.  Import Adjustments

 
When submitting the Payables Open Interface Import program, use the following values in the 
Parameters window: 
 
Invoice Batch Name = TRUSBmmddyyADJ 
Source = GTA 
Purge Successful Records = Yes 
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Submitting the Payables Open Interface Import 

Purpose 

The purpose of this document is to describe how to import invoices from the AP Open Interface 
table into the AP Invoice Workbench. 

NIH Payables User 

N > Other > Requests > Run 

Submit a New Request 

  

1. Click the OK button to submit a single request. 

Result:  The Submit Request window will be displayed. 
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2. In the Name field, use the LOV to select Payables Open Interface Import. 

Result:  The Parameters window is displayed. 

 

3. Enter the report parameters as described below:  

 
Field Description 
Source Select the appropriate value from the LOV. 
Group Enter a group ID if applicable 
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Invoice Batch Name Enter a batch name following the appropriate naming 
convention 

Hold Name Select the appropriate hold name from the LOV if applicable 
Hold Reason Defaults based upon hold name 
GL Date Leave blank. 
Purge Select Yes. 
Summarize Report Defaults to No.  Do not change this value. 

4. Select the OK button to save the parameters. 

Result:  The parameters window closes.  

5. Select the Submit button to submit the Payables Open Interface Import.  

Result:  The Request window is displayed. 

6. Click on Refresh Data until the process completes normally. 

7. Click the View Output button to review the Payables Open Interface Import Report. 

End of activity. 
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Importing GTA Adjustment Invoices

¾ You should review the Payables Import 
Execution Report that is generated 
automatically when you run the import program 
for the adjustments

¾ Report any errors to the NIH Help Desk

1.  Import Adjustments

 
The first part of the report, Payables Open Interface Audit Report, details the invoices that were 
successfully imported.  The second part of the report, Payables Open Interface Rejections 
Report, indicates the invoices that did not successfully import.  If there are any items on the 
Rejection report, contact the NIH Help Desk to have the issues resolved. 
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Record Adjustments

¾ Once the adjustments are imported into the 
Invoice Workbench, the invoices with the types 
Standard and Credit Memo may be recorded.

¾ DEBIT MEMOS SHOULD NOT BE 
RECORDED INITIALLY

TRxV#-CBGTACMYesCredit Memo

TRxV#-CBGTADMNODebit Memo

TRxV#-CBGTAYesStandard Invoice

Naming ConventionRecord Payment?Invoice Type

2.  Record Adjustments 
and Credits
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Validating GTA Standard and Credit Memo 
Invoices

Step 1:  
Validate the Standard and Credit Memo Invoices
¾ Locate the Standard invoices in the USB ADJ invoice batch

(Invoice Batch Name is TRUSBmmddyyADJ)
¾ Validate the standard invoices
¾ Locate the Credit Memos in the USB ADJ invoice batch
¾ Validate the credit memo invoices

2.  Record Adjustments 
and Credits

 
By not validating the Debit Memo adjustment invoices, the DMs will not be included in the USB 
recorded payment batches. 
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Validating GTA Standard and Credit Memo Adjustments 

Purpose 

The purpose of this document is to describe how to validate the standard and credit memo 
invoices that are included in the GTA adjustment invoice batch. 

NIH Payables User 

N > Invoices > Entry > Invoices 

Find Invoices 

 

1. In the Invoice Type field, use the drop down menu to select Standard. 

2. In the Invoice Batch, select the GTA Adjustment batch from the LOV. 

Example:  Below is a sample completed Find Invoices window. 
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3. Press the Find button. 

Result:  The Invoices window displays the standard invoices in that batch. 
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4. From the menu bar, select Edit > Select All 

Result:  The invoices displayed will turn blue. 

5. Select the Actions... button. 

Result:  The Invoice Actions window will be displayed. 
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6. Enable the Validate checkbox and select the OK button. 

Result:  The Invoices window is displayed and the highlighted invoices have been validated. 
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7. Press Find  button on the application toolbar. 

Result:  The Find Invoices window is displayed. 
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8. In the Invoice Type field, use the drop down menu to select Credit Memo. 

9. Press the Find button. 

Result:  The Invoices window displays the credit memo invoices in that batch. 
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10. From the menu bar, select Edit > Select All 

Result:  The invoices displayed will turn blue. 

11. Select the Actions... button. 

Result:  The Invoice Actions window will be displayed. 
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12. Enable the Validate checkbox and select the OK button. 

Result:  The Invoices window is displayed and the highlighted invoices have been validated 



   

GTA Reconciliation   
 Chapter 3 - Page 31  

 

End of activity. 
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Recording GTA Credit Memo Invoices

Step 2:  
Record each Credit Memo
¾ Locate the Credit Memos in the USB ADJ invoice batch

(Invoice Batch Name is TRUSBydddADJ)

¾ Record each credit memo individually
� Highlight a single line
� Select Actions button
� Enable the pay in full
� Select a B110 Transaction Code
� Use the base TR number in the Document field

2.  Record Adjustments 
and Credits
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Recording GTA Credit Memo Adjustments 

Purpose 

The purpose of this document is to describe how to record credit memo invoices that are 
included in the GTA adjustment invoice batch. 

NIH Payables User 

N > Invoices > Entry > Invoices 

Invoices 

 

1. In the Invoice Type field, use the drop down menu to select Credit Memo. 

2. In the Invoice Batch, select the GTA Adjustment batch from the LOV. 

Example:  Below is a sample completed Find Invoices window. 
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3. Press the Find button. 

Result:  The Invoices window displays the credit memo invoices in that batch. 
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4. Place your cursor in the first unpaid credit memo line. 

5. Select the Actions... button. 

Result:  The Invoice Actions window is displayed. 

 



   

GTA Reconciliation   
 Chapter 3 - Page 36  

6. Enable the Pay in Full checkbox and select OK. 

Result:  The Enter Transactions Events window is displayed. 

 

7. Use the LOV in the Transaction Event field to select AP Payments.  

Result:  The Transaction Code field will be populated with B110. 

8. Select the OK button. 

Result:  The Payments - Pay in Full window is displayed. 
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9. Tab to the Bank Account field and select Main Disbursement from the LOV. 

Result:  A caution message appears. 

 

10. Select the OK button. 

11. Tab to the Document Number field and enter the root travel order number. 

12. Save your work. 

Example:  Below is a sample completed refund. 

 

13. Close the Payments window. 

If there are additional unpaid credit memos, goto task #4. Otherwise, end of activity. 
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Recording GTA Standard and Credit Memo 
Invoices

Step 3:  
Create a recorded payment batch for
Impac Government Services

¾ Create the batch
� Batch Name = TRPmmddyyUSB
� Transaction Code = B110
� Supplier Name = Impac Government Services
� Document = USB.Recorded

¾ Build and Select the batch
¾ Review the preliminary report
¾ Format the batch
¾ Confirm the batch

2.  Record Adjustments 
and Credits

 
Refer to the NIH Payables User Student Guide for instructions on how to record the USB 
invoices through payment batches. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab 2:  Importing and Recording GTA Adjustment Invoices 
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Reconciling in Cash Management 

After this lesson you will know how to:

• Prepare TMC Invoices for Reconciliation

• Import and Record Adjusting Entries

ÎRun the Cash Management Reconciliation Program

• Run Reports to Review Reconci liation Results
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Importing and Reconciling TMC File

The first time that you access a file that has been
prepared by the DBA, you must

3.  Import and Reconcile 
TMC File

Accounts Payable

Cash Management
Bank Reconciliation

# Invoice #   Amount   Reconciled?

1 TR25 $150     Yes
2 TR26 $1125   Yes
3 TR27 $857     Yes
4 TR28 $125     Yes
5 TR29 $736     Yes
6 TR30 $356     Yes 
7 TR31 $125     Yes

1125

150

Amount

TR26

TR25

Document #

TMC File

Payment Workbench

Invoice#        Amount   Document

TR25V1-CB $150  Recorded
TR26V1-CB $1125Recorded
TR27V1-CB $857  Recorded
TR28V1-CB $125  Recorded
TR29V1-CB $736  Recorded
TR30V1-CB $356  Recorded
TR31V1-CB $125  Recorded

Adjustments
Invoice # Amount
TR24V1-CB GTA          $100
TR33V1-CB GTA          $30.50
TR20V1-CB CM          -$100

1. Import the file from 
the bank statement 
interface table

2. Run the 
Autoreconciliation 
program

1

2

 
The DBA loads the file into the Bank Statement Interface.  The NIH Cash Management GTA 
User must import the file from the Bank Statement Interface into the Bank Statement table.  At 
the same time the file is imported, we will run the reconciliation program as well. 
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Submit Import and Autoreconciliation Process 

Purpose 

The import and reconciliation process imports files into Oracle Cash Management to be 
reconciled with payments in Accounts Payable. This request actually contains two separate 
processes, the import of the file, and the reconciliation of its contents.   

NIH Cash Management GTA User 

N > Bank Reconciliation > Bank Statement Interface 

Find Bank Statement Interface 

 

1. Highlight the file you want to import and select the OK button. 

Result:  The Bank Statement Interface window is displayed. 



   

GTA Reconciliation   
 Chapter 3 - Page 43  

 

2. From the menu bar, select Tools > AutoReconciliation. 

Result:  The Submit Automatic Reconciliation window will appear. 
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3. Enable the Import and Reconcile button. 

4. Select the Submit... button. 

Result:  A Caution window appears. 

 

5. Select the OK button. 

Result:  A Note window will appear with your request ID. 
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6. Select the OK button. 

7. From the menu bar, select View > Requests 

Result:  The Find Requests window will appear. 

 

8. Select the Find button. 

Result:  The Requests window is displayed. 
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9. Select the Refresh Data button until AutoReconciliation Execution Report request Phase 
field indicates that the request has completed. 

10. Select the View Output button to review the report. 

End of activity. 
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Reviewing the Import Results

¾ Once you have submitted the Import and 
Autoreconciliation program, review the report 
that is generated

¾ If any lines failed to import, contact the NIH 
Help Desk

3.  Import and Reconcile 
TMC File

 
To review the import results: 
¾     Navigate to M > View > Requests 
¾     Select the Find button. 
¾     Highlight the AutoReconciliation Execution Report request 
¾     Select  View Output  
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Viewing the Import Results in the Bank 
Statement Window

¾ Once the Import and Reconciliation program is 
completed, you may view the bank statement 
lines in the Bank Statement window

3.  Import and Reconcile 
TMC File

 
The Bank Statement window will provide you with overview information related to the file.   
 
The Line Totals block will display the number of lines in the file and the total amount. 
 
The Unreconciled Amount and Lines fields display the total number of lines that remain 
unreconciled.  To view the lines of the file, select the Lines button. 
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Find Bank Statement Lines

¾ When you select the Lines button, the Find 
Bank Statement Lines window will appear

¾ To view all lines of the file, select Find
¾ To view specific lines of the file, enter your 

search criteria and select Find

3.  Import and Reconcile 
TMC File
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Page 26

Viewing the Import Results in the Bank 
Statement Window – Amounts Tab

¾ The detailed contents of the file are displayed 
in the Bank Statement Lines window

¾ The Amounts tab displays the line amount on 
the file, the amount reconciled (if applicable), 
and the transaction date

3.  Import and Reconcile 
TMC File
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Viewing the Import Results in the Bank Statement Window – 
Reference Tab 
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Viewing the Import Results in the Bank 
Statement Window – Reference Tab

¾ The Reference tab displays the invoice 
number on the file

3.  Import and Reconcile 
TMC File
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Viewing the Import Results in the Bank Statement Window – 
Description Tab 
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Viewing the Import Results in the Bank 
Statement Window – Description Tab

¾ The Description tab displays the error 
message generated from the customized 
program and the line status

3.  Import and Reconcile 
TMC File
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Viewing Bank Statement Lines 

Purpose 

This document describes how to view bank statement lines that were imported from an external 
file.   

NIH Cash Management GTA User 

N > Bank Reconciliation > Bank Statement 

Find Bank Statements 

 

1. Enter the search criteria to locate the bank statement. 

• Select the Account Number from the LOV. 

• Select the Statement Number from the LOV. 

2. Select the Find button. 

Result:  The Reconcile Bank Statements window displays the search results. 
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3. Select the Review button. 

Result:  The Bank Statement window is displayed. 

 

4. Select the Lines button. 
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Result:  The Find Lines window is displayed. 

 

5. Enter the appropriate search criteria and select the Find button. 

Result:  The Bank Statement Lines window displays the search results. 
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6. Review the information on the Amounts region tab. 

• If the Amount Reconciled field is blank, it indicates that the bank statement line has not 
been reconciled with a transaction in Accounts Payable. 

7. Select the Reference region tab. 

Result:  The reference fields are displayed, including the Invoice number field. 
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8. Select the Description region tab to review the status of the line and the custom 
reconciliation message. 

Result:  The description fields are displayed. 
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End of activity. 
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Locating Lines in the Bank Statement Lines 
Window

¾ You may use the Query-by-Example method to 
search for lines in the Bank Statement Lines
window

3.  Import and Reconcile 
TMC File

 
To search for bank statement lines using the query-by-example method: 
•   View all lines in the Bank Statement Lines window 
•   Press the F11 key 
•   Enter your search criteria on the Amount, Exchange, Reference, and Description tabs 
•   Press the Ctrl + F11 keys. 
 Result:  The lines matching your search criteria are displayed. 
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Practice Lab

Lab Time

 
Complete Lab 3:  Import and Reconcile TMC Files 
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Reconciliation Reports 
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Reconciliation Reports 

After this lesson you will know how to:

• Prepare TMC Invoices for Reconciliation

• Import and Record Adjusting Entries

• Run the Cash Management Reconciliation Program

ÎRun Reports to Review Reconciliation Results
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Submit the NIH Cash Management GTA Report

The NIHCE Cash Management Custom Extension 
Log will be used to identify:
� imported and reconciled
� imported and not reconciled
� other exceptions

¾ Use this report to start the reconciliation 
process

¾ This report can be run for a single file or all 
files.

4.  Run Reconciliation 
Reports
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Submitting the NIHCE Reconciliation Log Report 

Purpose 

The purpose of this document is to describe how to generate the NIHCE Reconciliation Interface 
Log. 

NIH Cash Management GTA User 

N > Other > Programs > Run 

Submit a New Request 

 

1. Select the OK button. 

Result:  The Submit Requests window is displayed. 
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2. Click on the LOV in the Name field and select NIHCE Cash Management Custom 
Extension Log 

Result:  The Parameters window is displayed. 
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3. In the Enter File Name field, select the file name that you want the report to run. 

Note:  To run the report for all files, leave this field blank. 

4. Select the OK button. 

Result:  The Parameters window closes. 

5. Select the Options button. 

Result:  The Upon Completion window is displayed. 
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6. In the Printer field, use the LOV to select your printer. 

7. In the Copies field, enter the number of copies you want to print. 

8. Select the OK button. 

9. Select the Submit button. 

Result:  The Requests window is displayed. 

10. Select the Refresh Data button until the Phase field displays "Completed" 

Note:  If the Status field displays anything other than "Normal," contact the NIH Help Desk. 

11. Select the View Output button to view the report. 

End of activity. 
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Practice Lab

Lab Time

 
Complete Lab 4:  Submitting the NIHCE Cash Management Reports 
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Lesson Summary 

After this lesson you know how to:

• Prepare TMC Invoices for Reconciliation

• Import and Record Adjusting Entries

• Run the Cash Management Reconciliation Program

• Run Reports to Review Reconci liation Results
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GTA Reconciliation 
Exceptions 
Chapter 4 
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GTA Reconciliation Exception Resolution 

GTA Reconciliation Exception Resolution

End User Training
Revised February 1, 2004
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Lesson Objectives 

After this lesson you will know how to:

• Research Exceptions and Determine Corrective Action

• Enter Adjustments 

• Reconci le Bank Statement Lines
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Reconciling GTA Charges

DBA Loads File and 
Runs Custom Program

Prepare and Load File

Email GTA User w hen 
complete

NIH GTA User Prepares 
Adjustments and 
Reconciles File

1.  Import Adjustments

2.  Record Adjustments 
and Credits

3.  Import and Reconcile 
TMC File

4.  Run Reconciliation 
Reports

5.  Research and 
Reconcile Exceptions

NIH GTA User Prepares 
TMC Files for 
Reconciliation

1.  Prepare TMC File

2.  Save File on Drive

3. Email DBA

Monthly 

 
Researching and resolving GTA Reconciliation exceptions is the final step in the overall process. 
This step may take multiple months depending upon the types of exceptions that are raised. 
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GTA Reconciliation and Exception Process 
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GTA Reconciliation and Exception Process

5.  Research and
Reconcile 
Exceptions

5A.  Research Exceptions 
and Determine Corrective 

Action

5B.  Take Corrective 
Action

5C.  Reconcile Bank 
Statement Lines
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Researching and Correcting Exceptions 
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Researching and Correcting Exceptions

After this lesson you will know how to:

ÎResearch Exceptions and Determine Corrective Action

• Enter Adjustments 

• Reconci le Bank Statement Lines
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NIHCE Reconciliation Interface Log 
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NIHCE Reconciliation Interface Log

¾ The NIHCE Reconciliation Interface Log will 
display: 
� the lines of the file
� the reconciliation indicator
� the error in the event did not reconcile

¾ Refer to the GTA Reconciliation Exception 
Resolution job aids for recommendations on 
how to research and reconcile exceptions

5A.  Research Exceptions 
and Determine Corrective 

Action
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Travel Orders and Adjustments Processed 
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Travel Orders and Adjustments Processed

Travel Orders and Adjustments Processed

This page details the travel orders and adjustments processed for which 
an invoice was found in Accounts Payable.

This page will not display lines of the TMC file that did not reconcile due 
to:
� No PO Found
� PO Cancelled
� No Invoice Found

5A.  Research Exceptions 
and Determine Corrective 

Action

 
If the line has a status of “Reconciled,” the bank statement line was matched to an AP payment. 
 
If the line has a status of “Unreconciled,” the bank statement line has not been matched to an AP 
Payment.  These lines will appear on subsequent pages of the report categorized by the error. 
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Travel Orders without Purchase Orders

Travel Orders without Purchase Orders

Exception Description:
The file contains a charge for which there is no corresponding purchase 
orders in the NBS

Potential Causes:

1. The TMC entered the travel document number incorrectly on the file

2. The travel document is not approved in the NBS Travel System

3. The travel document failed during the import from NBS Travel 
System into the AP Open Interface Table

5A.  Research Exceptions 
and Determine Corrective 

Action
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Travel Orders with Cancelled Purchase Orders

Travel Orders with Cancelled 
Purchase Orders

Exception Description:
The file contains a charge for which the corresponding purchase order 
has been cancelled

Potential Causes:

1. The approved travel authorization has been cancelled

2. Approved authorization has been cancelled and recreated with a new 
document number

5A.  Research Exceptions 
and Determine Corrective 

Action
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Travel Orders without Invoices

Travel Orders without Invoices

Exception Description:
The file contains a line for which no invoice was found in Accounts 
Payable.  A purchase order was found for the travel order.

Potential Causes:

1. The travel voucher was not created in the NBS Travel System

2. The travel voucher was not approved in the NBS Travel System

3. The travel voucher failed during the import process into AP*

5A.  Research Exceptions 
and Determine Corrective 

Action

 
*Check the AP Import Error log to see if the invoice failed during import. 
 
As previously discussed, the business process decision that was made was to leave the lines in 
the unreconciled status until such time that the travel voucher is approved and imported into the 
NBS.  
 
OFM Travel Office may utilize nVision reports to monitor whether travelers complete the 
vouchering process in a timely manner. 
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Travel Orders with Debit Memos for Invoice

Travel Orders with Debit Memos for Invoice

Exception Description:
The file contains a charge for an invoice for which a debit memo currently 
exists. The debit memo was created due to a variance from the previous 
month’s file

Cause:

The TMC billed for two charges related to the same voucher number in 
separate months.

5A.  Research Exceptions 
and Determine Corrective 

Action
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Travel Orders with Invoice Unpaid

Travel Orders with Invoice Unpaid

Exception Description:
The file contains a line for which an invoice was found in Accounts 
Payable but was not paid.  Cash Management can only reconcile to paid 
invoices.

Cause:

The invoice was not recorded as paid.

5A.  Research Exceptions 
and Determine Corrective 

Action

 
The OFM Travel Office NIH Payables User should run the following reports prior to 
reconciliation to ensure that all Standard and Credit Memo invoices for Impac Government 
Services have been recorded as paid: 
• Invoice on Hold Report 
• Invoice Aging Report (Parameters:  Supplier Name = Impac Government Services) 
 
Refer to Chapter 3 for guidelines on recording Impac Government Services invoices. 
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Travel Order Previously Reconciled

Travel Orders Previously Reconciled

Exception Description:
The file contains a line for an AP invoice that was previously reconciled

Cause:

A new charge is presented with the same TR number and amount 
previously reconciled in an earlier file.

5A.  Research Exceptions 
and Determine Corrective 

Action
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Travel Orders with Sponsors

Travel Orders with Sponsors

Exception Description:
The file contains a line that cannot be automatically reconciled for which 
an invoice has been found in Accounts Receivable.

Potential Causes:

1. The file amount is greater or less than the AP invoice

2. The line failed to reconcile due to any of the other errors contained in 
the report

5A.  Research Exceptions 
and Determine Corrective 

Action
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Travel Orders with Multiple Lines

Travel Orders with Multiple Lines

Exception Description:
The file contains a charge for which an adjustment should be made.  The 
accounting on the file does not match the two or more accounting lines 
on the invoice in AP.
Potential Causes:

1. The file amount is greater or less than the AP invoice

2. The line failed to reconcile due to any of the other errors contained in 
the report

5A.  Research Exceptions 
and Determine Corrective 

Action
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Entering Adjustments

After this lesson you will know how to:

• Research Exceptions and Determine Corrective Action

ÎEnter Adjustments

• Reconci le Bank Statement Lines
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Types of Corrective Action

Depending upon the type of exception and 
research results, you may need to do one 
or more of the following:
� Record an AP Payment
� Correct a Bank Statement Line
� Delete a Bank Statement Line
� Enter an Adjusting Invoice in AP and 

record the payment
You may be required to contact the 
traveler or travel planner for additional 
information prior to taking corrective 
action.

5B.  Take Corrective 
Action
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Recording the AP Payment 
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Recording the AP Payment

¾ Cash Management reconciles TMC file 
lines to Accounts Payable Payments.

¾ Impac Government Services invoices are 
recorded through payment batches.  

¾ Refer to the NIH Payables User Student 
Guide for instructions on how to record 
USB invoices.

5B.  Take Corrective 
Action

 



   

GTA Reconciliation Exceptions   
 Chapter 4 - Page 20  

Correcting Bank Statement Line 
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Correcting Bank Statement Line

¾ If the TMC entered the incorrect invoice 
number in the file, you may correct the 
value on the bank statement line.

¾ Enter the correct value in the Invoice
field and save your changes.

5B.  Take Corrective 
Action
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Deleting a Bank Statement Line 
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Deleting a Bank Statement Line

¾ If the TMC entered an improper charge 
on the file, you may delete the line within 
the bank statement window. 

¾ Locate the bank statement line that you 
would like to delete and press the Delete
button on the application toolbar.

5B.  Take Corrective 
Action
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Entering Adjustments in AP

After conducting research, you may determine 
that adjustments are needed in Accounts Payable 
in order to reconcile the file amount with the AP 
amount.

Step 1:  Determine correct type of transaction
Step 2:  Determine correct accounting information
Step 3:  Enter the adjustment in AP
Step 4: Record the payments as necessary
Step 5:  Update the Bank Statement Lines with the adjustment information

5B.  Take Corrective 
Action

 
Step 1:   
• Standard invoices should be entered when the AP invoice is less than the amount on the 

TMC file. 
• Debit Memo invoices should be entered when the AP invoice is more than the amount on the 

TMC file. 
• Credit Memo invoices should be entered when a credit appears on the TMC file. 
 
Step 2: 
The accounting information may be gathered from the original invoice, the travel planner, or 
nVision. 
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Step 3:  Entering the Adjustments in AP 
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Step 3:  Entering the Adjustments in AP

Adjusting Invoices must be entered in batches.

B107x, where x is the 
fund typeNegativeTRxV#-CBGTACMCredit Memo

B107x, where x is the 
fund typeNegativeTRxV#-CBGTADMDebit Memo

B302x, where x is the 
fund typePositiveTRxV#-CBGTAStandard 

Invoice

Transaction CodeAmountInvoice NameInvoice Type

Invoice Batch Name = TRUSBmmddyyADJfile*

5B.  Take Corrective 
Action

* We recommend creating a single adjustment invoice batch per file per 
month
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Entering Invoice Batches 

Purpose 

The purpose of this document is to describe how to manually enter invoices into the NBS.  All 
manual invoices must be entered into NBS in batches.  Invoices that are entered manually will 
require the user to indicate the correct account code distribution, project, and task information.  
Once the invoice batch is entered, it will be necessary to validate and create accounting for the 
invoice as well.  Refer to Validating an Invoice On-Line [NAV1003A] and Creating Accounting 
for Invoices On-Line [NAV1006A]. 

Before you begin 

Before you begin, the following information must be available: 
− Supplier Name 
− Supplier Site 
− Invoice Number 
− Invoice Date 
− Payment Terms 
− Payment Method 
− Project Number 
− Expenditure Type 
− Expenditure Date 
− Transaction Code based on Fund Value 

 

NIH Payables User 

N > Invoices > Entry > Invoice Batches 

Invoice Batches 
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1. Enter a unique name for the invoice batch in the Batch Name field. 

Note:  The naming convention for this field should be followed.   

2. Tab to the Control Count field and enter the number of invoices in the batch. 

3. Tab to the Control Amount field and enter the total dollar value of the invoices in the 
batch. 

4. Save your work. 

Example:  Below is a sample completed Invoice Batches window. 

 

5. Select the Invoices button. 

Result:  The Enter Transaction Events window is displayed. 
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If a transaction code should be entered, goto task #7. Otherwise, goto task #6. 

6. Close the Enter Transaction Events window by clicking on the X in the upper right corner. 

Result:  A Caution window appears. 

Goto task #8. 

7. In the Transaction Event field, select the appropriate transaction code from the LOV.  

Result:  The Transaction Code field value defaults. 

8. Select the OK button. 

Result:  The Invoices window is displayed. 

 

9. In the Type field, select the appropriate type of invoice from the LOV.   

10. Tab to the Supplier field and select the appropriate supplier name from the LOV. 

Result:  The Supplier Number field defaults. 

Note:  You may receive a message indicating that a prepayment is available. 
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11. Enter the remaining invoice information based upon the table below: 

Note:  If a field is not referenced in this table, it is not required.  Do not complete any fields 
that are not listed below. 

 
Field Description 

Site Accept default value or select the appropriate site from the 
LOV 

Invoice Date Enter the invoice date 
Invoice Number Enter a unique invoice number 
Invoice Currency Defaults to USD 
Invoice Amount Enter the amount of the invoice 
Project Enter the Project information  
Task Select the Task information from the LOV 
Expenditure Type Select the Expenditure Type from the LOV 
Expenditure Item Date Enter the Expenditure Date 
Expenditure Organization Select the Expenditure Org from the LOV 
GL Date Defaults.  Do not change 
Payment Currency Defaults to USD.  Do not change 
Description Enter a description of the invoice. 
Payment Rate Date Defaults to current date.  Do not change 
Transaction Code Defaults from value entered in Enter Transaction Code 

window.  Do not change 
Terms Date Defaults to the current date. 
Terms Defaults from value entered in Invoice Batches window. 

If necessary, use the LOV to select a different term. 
Payment Method Defaults from what is entered on the Invoice Batches 

window.  If necessary, use the LOV to select a different 
payment method.  

Pay Group Defaults from value entered in Invoice Batches window 

Example:  Below is a sample completed invoice line. 
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If you want to apply a prepayment, goto task #12. Otherwise, goto task #19. 

12. Select the Actions button. 

Result:  The Invoice Actions window is displayed. 
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13. Enable the Apply/Unapply Prepayment checkbox and select the OK button. 

Result:  The Apply/Unapply Prepayment window is displayed.  The available prepayments 
are displayed in the upper portion of the window. 
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14. Enable the Apply checkbox on those prepayment lines you want applied to the invoice. 

15. Enable the Prepayment on Invoice checkbox. 

16. Update the Amount To Apply field as necessary. 

Example:  Below is a sample completed window. 
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17. Select the Apply/Unapply button. 

Result:  The applied prepayment is displayed in the Existing Prepayment Applications 
block. 
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18. Close the Apply/Unapply Prepayments window. 

Result:  You are returned to the Invoices window. 
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If the invoice total matches the distribution total, end of activity. Otherwise, goto task #19. 

19. Select the Distributions button. 

Result:  The Distributions window is displayed. 
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20. Enter the following information in the first available distribution line: 

 
Field Description 

Amount Enter the amount that will be charged to the accounting 
information for that line. 
Note:  If entering a Debit Memo or Credit Memo, the amount 
must be entered as a negative. 

Project Enter the Project number 
Task Select 1 from the LOV 
Expenditure Type Select the Expenditure Type from the LOV 
Expenditure Item Date Enter the Expenditure Date 
Expenditure Organization Select HN from the LOV 

Notes:   
− If the Project, Task, Expenditure Type, Expenditure Item Date, and 

Expenditure Organization fields were not completed in the Invoice window, they 
must be completed in the Distributions window. 

− The total amount for all lines should equal the invoice total displayed in the top 
right hand corner of the screen. 

Note:  Below is a sample completed distributions window. 
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If the Invoice Total matches the Distribution Total, goto task #21. Otherwise, goto task #20. 

21. Close the Distributions window. 

Result:  You are returned to the Invoices window. 
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If there are additional invoices to enter, goto task #22. Otherwise, goto task #23. 

22. Place your cursor in the next line. 

Goto task #7. 

23. Close the Invoices window. 

Result:  You are returned to the Invoice Batches window. 

24. Review the Batch Control Total and Actual Total fields.  

End of activity.  
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Step 4:  Recording Payment 
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Step 4:  Recording Payment

¾ Once the adjustment invoices are entered, the 
standard and credit memo invoices must be 
recorded.
� Standard Invoices may be recorded in 

payment batches
� Credit Memos must be recorded individually 

from the Invoices window

¾ Refer to Chapter 3 in this manual for detailed 
instructions on recording Standard and Credit 
Memo invoices

5B.  Take Corrective 
Action
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Step 5:  Updating Bank Statement Lines 
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Step 5:  Updating Bank Statement Lines

¾ Once the adjustment invoices are entered 
and recorded, you must update the bank 
statement lines to reflect the adjustment.

5B.  Take Corrective 
Action

� Standard Adjustments
� Update the existing bank statement line amount to the original invoice amount
� Insert a line for the adjustment invoice

� Debit Memos
� Update the existing bank statement line amount to the original invoice amount
� Enter a new  line for the debit memo amount

� Credit Memos
� No update is needed

¾ Use the Bank Statement Lines job aid as a reference for creating new 
bank statement lines.
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Modifying Bank Statements 

Purpose 

The purpose of this document is to describe how to update bank statement lines as part of the 
GTA reconciliation process.  This process will be required if the TMC made an error on the file 
or adjustment invoices were made in Accounts Payable. 

NIH Cash Management GTA User 

N > Bank Reconciliation > Bank Statements 

Find Bank Statements 

 

1. Enter the search criteria to locate the bank statement. 

• Select the Account Number from the LOV. 

• Select the Statement Number from the LOV. 

2. Select the Find button. 

Result:  The Reconcile Bank Statements window displays the search results. 
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3. Place your cursor in the line of the bank statement you want to modify and select the 
Review button. 

Result:  The Bank Statement window is displayed. 
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4. Select the Lines button. 

Result:  The Find Lines window is displayed. 

 

5. Enter the appropriate search criteria and select the Find button. 

Result:  The Bank Statement Lines window displays the search results. 
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If you want to enter a new line, goto task #6. Otherwise, goto task #12. 

6. Select the New  button on the applications toolbar. 

Result:  A blank line is inserted in the Bank Statement Lines window. 
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7. Complete the required fields on the Amounts tab as described below: 

 
Field Name Description 

Type Defaults to Payment. Do not change. 
Code Use the LOV to populate 01. 
Amount Enter the amount of the line. 

Example:  Below is a sample completed Amounts tab. 
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8. Select the Reference tab and complete the required fields as described below: 

 
Field Name Description 

Agent Use the Shift + F5 keys to copy the value above. 
Invoice Enter the appropriate invoice number. 

Example:  Below is a sample completed Reference tab. 
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9. Select the Description tab. 

10. Enter the details of the bank statement line in the Description field.  

Example:  Below is a sample completed Description tab. 
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11. Save your changes. 

End of activity. 

12. Locate the line that you want to update by scrolling through the search results or using the 
query-by-example method to search. 

13. Update the bank statement line according to the information below: 

 
Region Tab Field Name Description 

Amounts Amount Enter the correct amount for the line 
Reference Invoice Enter the correct invoice number 
Description Description Enter the correct description or delete if 

reconciled. 

14. Save your changes. 

End of activity. 
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab 5:  Entering Adjustments in AP 
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Reconciling Lines in Cash Management 
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Reconciling Lines in Cash Management 

After this lesson you will know how to:

• Research Exceptions and Determine Corrective Action

• Enter Adjustments 

ÎReconcile Bank Statement Lines 
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Reconciling Lines in Cash Management 
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Reconciling Lines in Cash Management

¾ Once corrective action is taken, the AP 
payments must be reconciled to the bank 
statement lines

¾ To reconcile AP payments to bank statement 
lines you must take steps in both AP and Cash 
Management

5C.  Reconcile Bank 
Statement Lines

Step 1:  Mark the invoice as reconciled in AP

Step 2:  Delete text in Bank Statement Line Description field

Step 3:  Run Autoreconciliation 
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Step 1:  Updating the Invoice Flexfield as Reconciled 
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Step 1:  Updating the Invoice Flexfield as 
Reconciled

The flexfield on the invoice should be updated to 
indicate that the invoice will be reconciled.

5C.  Reconcile Bank 
Statement Lines

 
Step 1:  Locate the AP Invoice 
Step 2:  Place your cursor into the flexfield 
Step 3:  Type a Y into the Reconcile Flag field and select the OK button 
Step 4:  Save your changes 
 
Updating the Invoice flexfield will allow the custom program to identify the line as being 
reconciled when future files are imported. 
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Step 2:  Delete Bank Statement Line Description 
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Step 2:  Delete Bank Statement Line 
Description

Remove the text in the Description field of the Bank Statement line so 
the exception does not continue to be displayed on the NIHCE 
Reconciliation Interface Log

5C.  Reconcile Bank 
Statement Lines
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Step 3:  Reconcile the Bank Statement 
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Step 3:  Reconcile the Bank Statement

The Autoreconciliation program is found on the 
Reconcile Bank Statements window under the 
menu path Tools

5C.  Reconcile Bank 
Statement Lines

 
Once you have taken action in the bank statement lines window or Accounts Payable, you may 
run the AutoReconciliation program again to reconcile the lines that have been corrected. 
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Submitting the Automatic Reconciliation Program 

Purpose 

This document describes how to submit the automatic reconciliation program in cash 
management.   

NIH Cash Management GTA User 

N > Bank Reconciliation > Bank Statement 

Find Bank Statements 

 

1. Enter the search criteria to locate the bank statement. 

• Select the Account Number from the LOV. 

• Select the Statement Number from the LOV. 

2. Select the Find button. 

Result:  The Reconcile Bank Statements window displays the search results. 
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3. From the menu bar, select Tools > Autoreconciliation.... 

Result:  The Submit Automatic Reconciliation window is displayed. 
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4. Select the Submit... button. 

5. Select OK on the message window confirming that you want to submit the bank statement 
for automatic reconciliation. 

6. Select OK on the message that displays your request ID. 

7. From the menu bar, select View > Requests. 

8. Select the Find button. 

Result:  The Requests window is displayed. 
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9. Select the Refresh Data button until the AutoReconciliation Execution Report completes 
successfully. 

10. Select the View Output button to view the report. 

Example:  Below is an example of an AutoReconciliation Execution Report. 
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End of activity. 
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Refreshing the Report Results 
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Refreshing the Report Results

Once you have researched and resolved 
reconciliation errors, you may re-run the NIHCE 
Cash Management Reconciliation Log Report to 
confirm that the items have indeed been resolved 
and reconciled.

5C.  Reconcile Bank 
Statement Lines
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Practice Lab  
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Practice Lab

Lab Time

 
Complete Lab:  Reconcile Bank Statement Lines 
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Manually Reconciling Lines in Cash Management 
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Manually Reconciling Lines in Cash 
Management

In the event that two AP invoices should be 
reconciled to a single bank statement line, you 
will need to manually reconcile the two lines 
rather than use the auto reconciliation program.

5C.  Reconcile Bank 
Statement Lines

Step 1: Document the AP Payment numbers for the invoices

Step 2: Manually reconcile the lines through Cash Management
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Step 1:  Documenting the AP Payment Number 
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Step 1:  Documenting the AP Payment Number

5C.  Reconcile Bank 
Statement Lines

 
Step 1:  Locate the invoice 
Step 2:  Select the Payments button to view the payment number 
 
If the bank statement line will be reconciled to two AP invoice transactions, you should 
document both payment numbers. 
 
Note:  This is required only in the event that you cannot use the Autoreconciliation Program to 
reconcile the lines within Cash Management.  This would be required if you are reconciling one 
bank statement line to two AP transactions.  
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Step 2:  Manually Reconciling Lines in Cash Management 
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Step 2:  Manually Reconciling Lines in Cash 
Management

To manually reconcile bank statement lines, 
select the Available button to view available 
Accounts Payable payments

5C.  Reconcile Bank 
Statement Lines
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Manually Reconciling Lines in Cash Management 

Purpose 

This document describes how to view bank statement lines that were imported from an external 
file.   

Before you begin 

Before you begin to manually reconcile bank statement lines with AP payments,  you must first 
locate the payment document number for the invoice you want to reconcile. 

NIH Cash Management GTA User 

N > Bank Reconciliation > Bank Statement 

Find Bank Statements 

 

1. Enter the search criteria to locate the bank statement. 

• Select the Account Number from the LOV. 

• Select the Statement Number from the LOV. 

2. Select the Find button. 

Result:  The Reconcile Bank Statements window displays the search results. 
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3. Select the Review button. 

Result:  The Bank Statement window is displayed. 

 

4. Select the Lines button. 
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Result:  The Find Lines window is displayed. 

 

5. Enter the appropriate search criteria. 

Note:  You may select a Status of Unreconciled to view only unreconciled lines. 

6. Select the Find button. 

Result:  The Bank Statement Lines window displays the search results. 
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7. Place your cursor in the unreconciled line that you would like to review. 

Note:  If the line that you want to reconcile is not visible, use the query-by-example method 
of searching to find the line you want to reconcile. 

10. Select the Available button. 

Result:  The Find Transactions window is displayed. 
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11. Enter your search criteria to locate the AP payment to which you want to reconcile the bank 
statement line. 

Notes:  If you have the payment document number, enter it into the Numbers fields on the 
Transaction tab. 

12. Select the Find button. 

Result:  Your search results are displayed in the Available Transactions window. 
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If you find the matching invoice, goto task #14. Otherwise, goto task #13. 

13. Select the Find button on the application toolbar. 

Goto task #11. 

14. Mark the transaction or journal entry you want to reconcile by checking the box to the left of 
the item's information. 

Result:  The line is highlighted and the remaining fields in the Account Currency block are 
populated. 



   

GTA Reconciliation Exceptions   
 Chapter 4 - Page 69  

 

15. Select the Reconcile button. 

Result:  The transaction is reconciled to the bank statement line and you are returned to the 
Bank Statement Lines window. 
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End of activity. 
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Select DONE button
when finished. (9)

Select AVAILABLE
button to search for
detail or batch
transactions
available for
reconciliation. (10)

Enter your search
criteria in Find
Transactions window.
(11)
Select FIND button.
(12)

You find matching
invoice?

Select FIND button
on application
toolbar. (13)

Mark transaction or
journal entry you
want to reconcile by
checking box to left
of item's info. (14)
Select RECONCILE to
reconcile selected
items against
current statement
line. (15)

Additional lines to
reconcile?

End

Close Available
Transactions window.
(16)

A

B

B

A

Y

N

Y

N

N

Y

 



   

GTA Reconciliation Exceptions   
 Chapter 4 - Page 72  

Unreconciling Lines 

Page 35

Unreconciling Lines

¾ You may unreconcile lines that you have 
previously reconciled.

5C.  Reconcile Bank 
Statement Lines
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Manually Unreconciling Lines in Cash Management 

Purpose 

This document describes how to manually unreconcile bank statement lines to accounts payable 
payments. 

NIH Cash Management GTA User 

N > Bank Reconciliation > Bank Statement 

Find Bank Statements 

 

1. Enter the search criteria to locate the bank statement. 

• Select the Account Number from the LOV. 

• Select the Statement Number from the LOV. 

2. Select the Find button. 

Result:  The Reconcile Bank Statements window displays the search results. 
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3. Select the Review button. 

Result:  The Bank Statement window is displayed. 

 

4. Select the Lines button. 
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Result:  The Find Lines window is displayed. 

 

5. Enter the appropriate search criteria. 

Note:  You may select a Status of Reconciled to view only reconciled lines. 

6. Select the Find button. 

Result:  The Bank Statement Lines window displays the search results. 
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7. Place your cursor in the line you want to unreconcile. 

Note:  If the line that you want to reconcile is not visible, you may use the query-by-
example mode to search for the line you want to unreconcile. 

8. Select the Reconciled button to locate the AP payment. 

Result:  The Reconciled Transactions window is displayed. 
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9. Mark the transaction you want to unreconcile by checking the box to the left of the item's 
information. 

Result:  The line is highlighted and the GL Date field is populated. 
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10. Select Unreconcile button to unreconcile the selected items against the current statement 
line. 

Result:  You are returned to the Bank Statement Lines window and the line is no longer 
reconciled to that AP transaction. 
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End of activity. 
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Practice Lab  

Page 36

Practice Lab

Lab Time
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Lesson Summary 

Page 37

Lesson Summary 

After this lesson you know how to:

• Research Exceptions and Determine Corrective Action

• Enter Adjustments 

• Reconci le Bank Statement Lines
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